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ModusToolbox™ tools package version 3.0.0

About this document

Scope and purpose

ModusToolbox™ software is a set of tools that enable you to integrate our devices into your existing
development methodology. One of the tools is a multi-platform, Eclipse-based Integrated Development
Environment (IDE) that supports application configuration and development.

The ModusToolbox™ ecosystem includes loT development platforms like Amazon FreeRTOS, in addition to the
software installed on your computer and available on GitHub. For a more comprehensive description of the
ModusToolbox™ software, refer to the ModusToolbox™ tools package user guide.

Intended audience

This document provides information about creating applications as well as building, programming, and
debugging them. This guide primarily covers the Eclipse IDE aspects of these concepts. It also covers various
aspects of the software installed along with the IDE, where applicable. For information about using Amazon
FreeRTOS, refer to their website.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus

Italics Denotes file names and paths

Courier New Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,
directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Reference documents

Refer to the following documents for more information as needed:

e ModusToolbox™ tools package installation guide

e ModusToolbox™ tools package user guide

e Eclipse survival guide

e KitProg3 user guide
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1 Getting started

This section provides a basic walkthrough for how to create a couple applications using the IDE, selecting a
BSP. It also covers how to build and program them using the IDE and basic launch configurations supplied for
the applications.

e lLaunch Eclipse IDE

e Open Project Creator tool

e Create an application

e Build application

e Program application

e Export/share application

e |mport application

e Search online for code examples

e Search online for libraries/BSPs

e Access training material

1.1 Launch Eclipse IDE

The Eclipse IDE is installed in the following directory, by default:

<install_path>\ModusToolbox\ide_<version>\eclipse\

Note: If the software is not installed in the default location, you will need to set an environment variable.
Refer to the ModusToolbox™ tools package installation guide for details.

To launch the Eclipse IDE:

e On Windows, select the Eclipse IDE for ModusToolbox™ <version> item from the Start menu.

e Forother operating systems, run the "modustoolbox" executable file.
When launching the Eclipse IDE, it provides an option to select the workspace location on your machine. This
location is used by the IDE for creating and storing the files as part of application creation for a particular

platform. The default workspace location is a folder called "mtw" in your home directory. You may add
additional folders under the "mtw" folder or to choose any other location for each workspace.

For more details about Eclipse, refer to the Eclipse documentation, as well as the Eclipse survival guide.
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1.2 Open Project Creator tool

Click the New Application link in the Eclipse IDE Quick Panel.

b Qu.. @=Va. 6Ex. ®%Br. = O

Eclipse IDE for
ModusToolbox™

I E Mew Application I
E Import Existing Application In-Place

& Search Online for Code Examples
& Search Online for Libraries and BSPs
& Training Material

@, Refresh Quick Panel

b Project
b Launches
» Tools

» BSP Configurators

You can also select File > New > ModusToolbox™ Application.

hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™
File Edit Mavigate 5earch Project Run  Window Help
Mew Alt+Shift+N > ™ Project...

Open File... i Other.. Cirl+ M
4 Open Projects from File System...

S s e ModusToolbox™ Application  Ctr+7

These commands launch the Project Creator tool, which provides several applications for use with different
development kits. The kits available may change over time.

| Choose Board Support Package (B5P) - Project Creator 2.0 - O X
Settings  Help

Source Template

Enter filter text Browse.. | [ CYBCKIT-062-WIFI-ET
Kit Mame MCU/SOC/SIP Connectivity # || The PSoC™ 6 WiFi-BT Pioneer Kit is a low-cost hardware
PSoC™ 4 BSPs platform that enables design and debug of the PSoC™ 62
" MCU(CY2C6247BZ1-D54) and the Murata LBEESKL1DX

Y PSoC™ 6 85Ps Module (CYWA343W WiFi + Bluetooth Combo Chig).
CY8CEVAL-D8252 CY8C624ABZ1-52044 <none>
CYBCEVAL-06252-CYW343430M2IPAT CYBC624ABZ1-52D44 LBEESKL1VN (CYW43433KUBG) Kit Features:
CY8CEVAL-06252-LAI-4373M2 CY23C624ABZ1-52044 Sterling-LWB3+ (CYW4373EUBGT)
CYBCEVAL-DB252-MUR-43438M2  CY8C624ABZI-52D44 LBEESKLYN (CYW43439KUBG) *BLEVS0 .
CYBCKIT-062-BLE CYBC634TRZ1-BLDS3 <none> :;E’:“ ey '{‘Te”‘a‘e —
CYBCKIT-06252-43012 CY8CG24ABTI-52044 LBEESSBILY (CYW43012COWKWEG) . dustry_‘Emj'?r:;c’g‘é‘s’gﬁsg"e'" erace
CYACKIT-06254 CY3C6244L01-54D52 <none> o Full-speed USE
CY3CKIT-062-WIFI-BT CY3C6247BZI-D54 LBEESKL1DX (CYW4343WKUBG) o IEEE 602.11a/b/g/n WLAN
CY3CKIT-064B052-4343W CYBOBA4ABZI-52D44 LBEESKL1DX (CYW4342WKUBG)
CYACKIT-0645052-4343W CYSDE44ABZI-52D44 LBEESKL1DX (CYW4343WKUBG) Kit Contents:
CY3CPROTO-062-4343W CY3C624ABZI-52D44 LBEESKL1DX (CYW4343WKUBG) « CYECKIT-062-WIEI-5T evalustion board
CY8CPROTO-06253-4343W CY8C6245L01-53D72 LBEESKL1DX (CYW4343WKUBG) « TFT display shield with a 24" TFT display, light
CY3CPROTO-063-BLE CYBLE-416045-02 (CYBC6347B7I-BLD33) CYBLE-416045-02 (CYBCH347BZI-BLDS3) sensor, 6-axis motion sensor, and digital
CY8CPROTO-064B051-BLE CYBLE-416070-02 (CYB064478Z|-BLD53) CYBLE-416070-02 (CYB064478ZI-BLDS3) microphone

= > * USB cable

Summary: ~

BSP: CYBCKIT-062-WIFI-BT

Prece "hlevt” tn celect annlicatinn

Next > Close

@

For more details about using this tool, refer to the Project Creator user guide.
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1.3 Create an application

This section provides a walkthrough for creating a ModusToolbox™ application.

1.3.1 Choose board support package

The Project Creator tool displays a list of boards, showing the Kit Name, MCU, and Connectivity Device (if
applicable). As you select each of the kits shown, the description for that kit displays on the right. Depending on
the settings for your system, you may see different categories, including PSoC™ 4, PSoC™ 6, and AIROC™
Bluetooth® BSPs. For this example, select the CYS8CKIT-062-WIFI-BT kit.

[ Choose Board Support Package (BSP) - Project Creator 2.0 - O X
Settings  Help

Source Template

Enter filter text Browse.. | |2 CYBCKIT-D62-WIFI-ET
Kit Mame MCU/S0C/SIP Connectivity || The PSoC™ 6 WiFi-BT Pioneer Kit is a low-cost hardware
PSoC™ 4 BSPs platform that enables design and debug of the P5oC™ 62

v Baaen§ BSP MCU(CYBC6247B71-D54) and the Murata LBEESKL1DX
CVBCEYAL 0625 CYBCEARZS2044 crones Module (CYWA343W WiFi + Bluetooth Combo Chig).
CYBCEVAL-D6252-CYWO43430M2IPAT CYBCG24ABZI-52D44 LBEESKLTYN (CYW43439KUBG) Kit Features:
CYBCEVAL-D6252-LAI-4373M2 CYBCA24AB7I-52D44 Sterling-LWB5+ (CYW4373EUBGT)
CYSCEVAL-062S2-MUR-43430M2  CY8C624ABZI-52D44 LBEESKLIVIN (CYW43439KUBG) *BLEV5.0
CYACKIT-062-BLE CY3C6347B71-BLDS3 <none> * Serial memory interface .
CYBCKIT-06252-43012 CYBCE244BZ1-52D44 LEEESOBILY (CYW43012C0WKWEG) : Fn'?ms'tpr;m:d'?r:;ﬂ'c’gé‘s’asgg"e interface
CYBCKIT-06254 CY¥BCE244L0-54D92 <none> “Fullapeed USE
CYBCKIT-062-WIFI-BT CYBCG24TRZI-D54 LBEESKL1DX (CYWA4343WKUBG) « EEE 802, 11a/b/g/n WLAN
CYECKIT-0648052-4343W CYBOGMABZI-52D44 LEEESKL1DX (CYW4343WKUEG)
CYBCKIT-0645052-4343W CYSOB44ABZI-52D44 LBEESKLIDX (CYWA4343WKUBG) Kit Contents:
CYBCPROTO-062-4343W CYBCA24AB7I-52D44 LBEESKL1DX (CYWA4343WKUBG) o CYBCKIT-062-WIFL-BT evaluation hoerd
CYBCPROTO-06253-4343W CY¥BC6245L01-53D72 LBEESKLTDX (CYW4343WKUBG) o TFT display shield with & 2.4" TFT display, light
CYBCRROTO-063-BLE CYBLE-416045-02 (CYBCEMTRZI-BLDS3) CYBLE-416045-02 (CYBCAIATRZI-BLDS3) sensor, 6-axis motion sensor, and digital
CYBCPROTO-064B051-BLE CYBLE-416070-02 (CYBO6447B71-BLDS3) CYBLE-416070-02 (CYBOGA4TBZI-BLD53) w microphone

< 5 *USE cable

Summary: -

BSP: CYBCKIT-062-WIFI-BT

Drece "Rlevt” to celact annl

Next > Close

@

1.3.2 Select application

Click Next > to open the Select Application page. This page lists various applications available for the selected
kit. As you select an application, a description displays on the right. You can select multiple applications for the
selected BSP by enabling the check box next to the applicable applications.

| Select Application - Project Creator 2.0 - m] ®

Settings  Help

Application(s) Root Path: |C:/Users/follettcj/mtw3.0 Browse...

Target IDE: Eclipse IDE for ModusToolbox™ ~

Search... Browse.. | F B2 Bz & This code example demonstrates simple UART communication by printing a “Hello
Werld" message on a terminal and blinks an LED using a Timer resource.

Template Application New Application Name

Bluetooth® For more details, see the README on GitHub.

~ Getting Started

[] Dual-CPU Empty PSaC6 App
[ Empty App
Hello Werld [Hello_World]
[ security 2pp
[ Switching Power Modes

Graphics

Machine Learning

Manufacturing

Peripherals

Sensing

Voice

Wi-Fi

lemplate Application(s): Hello World -
Application(s) Root Path: C:/Users/follette)/mtw3.0

Press "Create” to create the selected application(s).

< Back Create Close

@
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For this example:

e Select the check box next to the "Hello World" application.

o Ifdesired, type a name for the application under New Application Name. Do not use spaces in the
application name. In this case, we use the default "Hello_World" as the name.

1.3.3 Project Creator Browse option

The Project Creator tool includes a Browse... button that you can use to create a new application from one
that already exists.

Note: This option creates an entirely new application that is independent of the original application.

This is useful when you want to make a copy of an application to experiment with changes without affecting
the orginal application. Refer to the Project Creator user guide for more details about the Browse feature.

1.34 Create application

Click Create to begin the application creation process.

remote: Enumerating objects: 164, done.
remote: Counting objects: 100% (9/9), done.
remote: Compressing ohjects: 100% (3/3), done.

=

Note: The application creation process performs a git clone operation, and downloads the selected
application from the GitHub website. Depending on the selected application, this process can take
several minutes.

When complete, the Project Creator tool closes automatically. In the IDE, a message displays about importing
the project:

File Edit Mavigate Search Project Run Window Help
Al [B-R -5 i S| St~ 0~ Q-i® ! RIS -
Q il
5P 22 450 WIR FP = O = O geoutine i3 = O
BST & §
(5 Hello_World There is no active editor
that provides an outline.
Importing Hello_World (1/1) ..
User Guide 6 of 35 002-24375 Rev. *J
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After several moments, the application opens with the Hello_World in the Project Explorer, and the README.md
file opens in the file viewer.

E hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™ - [m] X
File Edit MNavigate Search Project Run Window Help

1 [mif & [B-{-@ B [ER|SiH-0- - ®@F-FHE T H-FA-CFe-2-E
Q w|=

EyP.. 3 4%D. W¥R. R P. = O [ READMEmd I3 = 0 SZou.x = O

BE%® Y 3§ . ¢ B 3
ZDC He\lo_Wor\d HAL- HEHO World a + h1. HAL Helle world
=% mthb_shared h2. Requirements
. . . h2. Supported toolc]
This code example demonstrates a simple UART communication by printing h2. Supported kits (1
the "Hello world” message on a terminal and blinking an LED using a timer h2. Hardware setup
resource h2. Software setup
) . . h2. Using the code ¢
View this README on GitHub h2. Provisioning stey
Provide feedback on this code example :i gs:;:;:g
~ h2, Design and impl
H h3. Resources ani
Requ"ements h?. Related resource|
h2., Other resources
+ ModusToolbox&trade: software v3.0 or later (tested with v3.0) hé. Bocument histol
b Qu. (Ve G Ex. % Br. = O * PSoC™ 6 board support package (BSP) minimum required version:
4.0.0
. " = XMC™ 7200 evaluation kit BSP minimum required version: 1.0.0 v
Ecllpse IDE for * Programming language. C
ModusToolbox™ < =
Markdown Source | Preview < >
- Start

) Console [#] Problems g Progress 12 [ Memory (@ Terminal % 8 = 0O
[ Mew Application

No operations to display at this time.
& Import Existing Application In-Place
& Search Online for Code Examples
& Search Online for Libraries and BSPs
& Training Material

& Refresh Quick Panel

» Project ~

Writable Insert 1:1:0

Note: Many AIROC™ Bluetooth® applications contain multiple projects. For example, the BLE-

20819EVBO2 application contains projects for Bluetooth® Low Energy services such as anc, ans,
bac, bas, beacon, etc.

1.4 Build application

After loading an application, build it to generate the necessary files. Select a project. Then, in the Quick Panel,

click the Build <project> Application link. The following images show the Quick Panel for a typical PSoC™ MCU
application and an AIROC™ Bluetooth® application.

PSoC™ MCU Application AIROC™ Bluetooth® Application

~ Hello World

A Build Application

¥ Clean Application

~ Audio_20819EVB02

A Build Application

¥ Clean Application

~ Launches ~ Launches

** (L
Hello_World Debug (JLink) # Audio_20819EVBO2 Attach JLink

# Audio_20819EVB02 Attach_KitProg3_MiniProg4
@& Audio 20819EVBO2 Program

#* Hello_World Debug (KitProg3_MiniProg4)
0o Hello_World Program (JLink)

o Hello World Program (KitProg3 MiniProg4) % Generate Launches for Audio 20819EVB02
& Generate Launches for Hello_World
» Tools o
» Tools N < >

K >

Messages display in the Console, indicating whether the build was successful or not. For more details about
building applications and the various Consoles available, see the Build applications chapter.
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1.5 Program application

There are many more details about programming an application. This section only covers it briefly. For more
detailed information, see the Program and debug chapter.

In the Project Explorer, select the desired project. Then, in the Quick Panel, click the <app-name> Program
(KitProg3_MiniProg4) link for a PSoC™ MCU application, and <app-name> Program for an AIROC™ Bluetooth®

application.

PSoC™ MCU Application AIROC™ Bluetooth® Application
~ Hello_ World - Audio_20819EVB02
& Build Application & Build Application
¥ Clean Application ¥ Clean Application
~ Launches * Launches
*# Hello World Debug (ILink)  Audio 20819EVBO2 Attach JLink
* Hello_World Debug (KitProg3_MiniProg4) # Audio_20819EVB02 Attach_KitProg3_MiniProg4
© Hello_World Program (ILink) % Audio_20819EVBO2 Program
© Hello_World Program (KitProg3_MiniProg4) A Generate Launches for Audio 20819EVB02
A Generate Launches for Hello_World
+ Tools
» Tools ™ 4
e >
1.6 Export/share application

There are several ways to share a ModusToolbox™ application. Refer to the ModusToolbox™ tools package user
guide in the "Using applications with third-party tools" chapter for more general details.

Using the Eclipse IDE, you can use the export function to essentially make a copy of your application that you
can share with a colleague. There are several ways to export using Eclipse. One option is to use Export >
General > Archive File, which creates a ZIP file.

& Export O 'Y
Select b |
/
Export resources to an archive file on the local file system. E E
Select an export wizard:
[type fitter text |
v [= General
| Archive File
L7 File System
7] Preferences
= CfC++
(= Install
(= Run/Debug
(= Team
@ < Back i Cancel

Keep in mind that a typical ModusToolbox™ application includes many libraries that are available on GitHub.
These get regenerated during the make getlibs command. Therefore, you can substantially reduce the size
of your exported application by excluding the libraries. Plus, the exported mtb_shared folder might retain hard-
coded paths that would cause issues after importing the application.

For multi-core applications, the Eclipse IDE export function shows the core project folders along side the main
application folder. These project folders are included in that main application folder, so you should exclude

them from the export process as well.

80f35 002-24375 Rev. *J

User Guide
2022-09-27


http://www.infineon.com/ModusToolboxUserGuide
http://www.infineon.com/ModusToolboxUserGuide

o~ _.
Eclipse IDE for ModusToolbox™ user guide In f| neon

Getting started

On the Export dialog, select only the main application folder(s) to export. You may need to review your
application in Eclipse to determine which folders you should exclude. By default, subproject folders include an
extension after the application name.

ﬁ Export

Archive file

[m]
X

Please enter a destination archive file.

1125 XMCT7200_Multicore_Empty_App I =) cproject ~
T “FPE-proj_cmip =| .gitignore

]S KMC7200_Multicore Empty_App.proj_cm7_0
]S XMC7200_Multicore Empty_App.praj_cm7_1
1S mtb_shared

z

mtbqueryapi

project
| LICENSE
& Makefile v

Filter Types... Select All Deselect All

To archive fil: ~|| Browse..
Options

(® Save in zip format (@ Creste directory structure for files

(O Save in tar format (O Create only selected directories

Compress the contents of the file

[] Resolve and expert linked resources
@ < Back Mext > Einish Cancel

Click Browse... to navigate to the location to save the archive and provide a file name.

Click Finish to generate the archive file.

1.7 Import application

If you have a ModusToolbox™ application that you want to import into the Eclipse IDE, run the make getlibs
command or use the Library Manager Update button on the application before importing it into Eclipse.

Note: If the application is included in a ZIP file, you will need to extract it before running various
commands.

Then, use the Import Existing Application In-Place link on the Quick panel.

Note: This option does not copy or move the application location on disk; it only makes a reference for
Eclipse to the current application location.

EQuic.. “~Vari.. “Exp.. ®Bre..
Eclipse IDE for
ModusToolbox™
~ Start

& New Application

| = Import Existing Application In-Place

% Search Online for Code Examples

® Search Online for Libraries and BSPs
& Training Material

A Refresh Quick Panel

User Guide 90f35 002-24375Rev. *J
2022-09-27



o~ _.
Eclipse IDE for ModusToolbox™ user guide In f| neon

Getting started

On the next page, click the Browse... button, navigate to the application directory, and click Select Folder.

[ Import Eclipse IDE for ModusToolbox™ Project O X
Project information.
Enter the directory of the ModusToolbox™ project to be imported.
Project Location: C:\Users\user\examples_lj\ Browse ...
@ Einish Cancel

Click Finish to begin the import process. This will take a few moments, and then the application will display in
the Eclipse IDE Project Explorer.

If the Console displays a message, such as "Error creating Eclipse configurations," open the Library Manager
and click Update. This runs the make getlibs operation to generate the necessary files and libraries.

Note: There are various ways to import examples into Eclipse. If you prefer a different method, make
sure that all of the project files are copied into the workspace directory.

1.8 Search online for code examples

Cypress provides many code examples. These examples allow you to explore the capabilities provided by the
SDK, create applications based on them, examine the source code demonstrated in them, and read their
associated documentation. The Quick Panel provides a link to access online code examples. Click the Search
Online for Code Examples link. This opens a web browser to the GitHub repository to select and download the
appropriate examples.

EQuic.. “Vari.. FExp.. %Bre.. = -
e Code examples for ModusToolbox™ software
Eclipse IDE for

™
ModusToolbox There are hundreds of code examples available. Use the links below to find the example you want, learn more

~ Start about each repo, and discover how to bring that code example into your development environment.

E . - -
New Application For details on how to use a code example, see the Getting Started chapter of the ModusToolbox™ tools

= Import Existing Application In-Place package user guide.

# Search Online for Code Examples

7 - — See the individual Amazon FreeRTOS example repository for details on how to import each code example into
Search Online for Libraries and BSPs . i i ) i o i

a Amazon FreeRTOS build system respectively. Typically, you'll find the precise command line in the readme file.
Training Material

& Refresh Quick Panel Repo Description
PSoC™ 6 MCU This search link displays all PSoC™ 6 MCU examples for ModusToolbox™ software.
examples These examples demonstrate the MCU and its features and functionality.
PSoC™ 4 MCU This search link displays all PSoC™ 4 MCU examples for ModusToolbox™ software.
examples These examples demonstrate the MCU and its features and functionality.

This search link displays all XMC MCU examples for ModusToolbox™ software.
XMC MCU examples . L
These examples demonstrate the MCU and its features and functionality.

PMG1 MCU This search link displays all PMG1 MCU examples for ModusToolbox™ software.
examples These examples demonstrate the MCU and its features and functionality.
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1.9 Search online for libraries/BSPs

Cypress also provides all the libraries and BSPs online at GitHub. The Quick Panel provides a link to access

these. Click the Search Online for Libraries and BSPs link. This opens a web browser to the GitHub repository

that shows the ModusToolbox™ software page.

& Quic... *-Vari.. % Exp.. ® Bre.

Eclipse IDE for
ModusToolbox™

~ Start

& New Application

= Import Existing Application In-Place
@ Search Online for Code Examples

# Search Online for Libraries and BSPs

€ Training Material
& Refresh Quick Panel

= g

ModusToolbox™ software

ModusToolbox™ software is a modern, extensible development environment supporting a wide range of Infineon
micracontroller devices. It provides a flexible set of tools and a diverse, high-quality collection of application-focused
software. These include configuration tools, low-level drivers, libraries, and operating system support, most of which
are compatible with Linux, macQS, and Windows-hosted environments.

This page helps you identify and find the ModusToolbox™ resources available. These resources are grouped in the
following top-level categories:

* Tools
* Code examples (link to separate page)
* Board support packages

* Libraries

Tools

The ModusToolbox™ tools package installer (https://www.cypress.com/products/modustoalbox-software-
environment) provides various multi-platform development tools to help you work in your preferred flow. The installer
includes a make-based build system, Eclipse IDE, configurators, stand-alone project creator and library manager, as
well as support for using other IDEs, generating code, compiling, pregramming, and debugging. Refer to the
ModusToolbox™ user guide for complete details.

1.10 Access training material

Cypress also provides training material at GitHub. The Quick Panel provides a link to access these. Click the
Training Material link. This opens a web browser to the GitHub repository that shows the ModusToolbox™

training page.

& Quic.. ¥-Vari.. * Exp.. s Bre..

Eclipse IDE for
ModusToolbox™

~ Start

= New Application

= Import Existing Application In-Place
@ Search Online for Code Examples

% Search Online for Libraries and BSPs

& Training Material

A Refresh Quick Panel

= O

User Guide

ModusToolbox™ Software Training

This page contains links to ModusToolbex™ training classes that are available on GitHub. These classes are organized
in a modular fashion and broken into levels. Each class is focused on a specific area so that you can learn about a topic
quicker and build upon your knowledge as your needs evolve.

The level 1 getting started class covers the basic concepts and building blocks of ModusToolbox™. Level 2 classes
cover a product or product family such as PSoC™. Level 3 classes cover more advanced systems such as Bluetooth®,
Wi-Fi, or Machine Learning.

ModusToolbox™ Software Training Level 1 - Getting Started

o This is the entry-level ModusToolbox™ training class. It is a pre-requisite for all level 2 and level 3 ModusToolbox™
training classes.

* This class is a survey of the ModusToolbox™ development platform. The learning objective is to intreduce you to
all the tools in the ModusToaolbox™ ecosystem and help you develop some familiarity with using them. The class is
“a mile wide and an inch deep.” This should enable you to understand the scope of the development ecosystem
and teach you where to find “everything.”
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2 IDE description

The IDE is based on the Eclipse IDE. It uses several plugins, including the Eclipse C/C++ Development Tools
(CDT) plugin. For more information about Eclipse, refer to the Eclipse Workbench User Guide. We also provide a
document called the Eclipse IDE survival guide, which provides tips and hints for how to use the Eclipse IDE.

The IDE contains Eclipse standard menus and toolbars, plus various panes such as the Project Explorer, Code
Editor, and Console. One difference from the standard Eclipse IDE is the "ModusToolbox™ Perspective." This
perspective provides the "Quick Panel," and adds tabs to the Project Explorer. "Perspective" is an Eclipse term
for the initial set and layout of views in the IDE.

[ hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™ - u] X
Eile Edit Navigate Search Project Run Window Help Menus &
Al | ®-RrRmiE! 4 SR EiH-0-%~®™ 5 Toolb R
oolbars Q im|E
EyP. 22 4D M¥R. ZP. = O [% READMEmd i3 = B8 ZEoui.x = 08
S - =l
rid: HAL: Hello world " hl. HAL Hello world
5 mib_shared h2. Requirements
h2. Supported toolc]
This code example demonstrates a simple UART communication by printing ha. s:z;zrt:d ;:S ;
Project the "Hello world” message on a terminal and blinking an LED using a timer h2. Hardware setup
resource. h2. Software setup
h2. Using the cod
Explorer View this README on GitHub o P ]
Provide feedback on this code example. :; gpmtm"
. Debugging
~ h2. Design and impl
H h3. Resources ani
Req UIrements h2. Related rescurce|
COde Ed ItOF h2. Other rasour.cas
+ ModusToolbo later (tested with v3.0) h2. Document histol
. =Va. ffEx. %Br. = O » PSoC™ 6 boarosupporpackage To=P) minimum required version:
400
. ~ = XMC™ 7200 evaluation kit BSP minimum required version: 1.0.0 v
ECl'Pse IDE for » Programming language C
ModusToolbox™ < >
Markdown Seurce | Preview < >
v Start & Console [£l! Problems &3 Progress 52 [] Memory { Terminal % 8§ = O
Q New Application
Ne cperations to display at this time.
¥ e
4 Quick Panel
4 Console
& Training Material
&, Refresh Quick Panel
» Project v
0 items selected
Note: If you switch to a different perspective, you can restore the ModusToolbox™ Perspective by clicking

the ModusToolbox™ icon button in the upper-right corner. You can also select Perspective > Open
Perspective from the Window menu. To restore the ModusToolbox™ Perspective to the original
layout, select Perspective > Reset Perspective from the Window menu.

The following describe different parts of the IDE:

e Menus and toolbars - Use the various menus and toolbars to access build/program/debug commands for
your application. Many of these are covered in the Eclipse Workbench User Guide.

e Project Explorer - Use the Project Explorer to find and open files in your application. See Project Explorer
for more information.

e Quick Panel - Use this tab to access appropriate commands, based on what you select in the Project
Explorer.

e Code Editor - Use the Code Editor to edit various source files in your application.

e Console - Use these tools to review messages and access the integrated terminal.
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2.1 Project Explorer

In the Eclipse IDE, after creating an application, the Project Explorer contains one or more related project
folders. The following images show a PSoC™ MCU application and an AIROC™ Bluetooth® application.

PSoC™ MCU Application AIROC™ Bluetooth® Application
[T Project Explorer &2 = 0 I Praject Explarer &2 = 0
55 T 8 05 T g
w =% Hello_World v == LE_Hello_Client
[ Includes ;;—P‘ Binaries
= bsps ! Includes
= build (= build
= deps = deps
= images = libs
(= libs [ hello_client.c
[ main.c helle_sensor.h
= LICENSE [ wiced_bt_cfg.c
Makefile = LICENSE.txt
[#] README.md makefile
== mtb_shared = makefile.init

README.md

=| wersion.xml
== LE_Hello_Sensor
== mtb_shared

Both types of applications contain a similar project structure. Each contains the main application source code,
and a Makefile. Note that PSoC™ MCU applications contain a libs directory, while AIROC™ Bluetooth®

applications have a wiced_btsdk project with shared SDK, BSPs, and libraries for all applicationsin a
workspace.
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2.2 Quick Panel

As stated previously, the Quick Panel is part of the "ModusToolbox™ Perspective." It provides quick access to
commands and documentation based on what you have selected in the Project Explorer.

PSoC™ MCU Application AIROC™ Bluetooth® Application

& Quic.. (0=Varia.. &fExpr.. 9 Brea. = O & Quic.. (9=Varia.. 6 Expr.. 9 Brea. = B

~

Eclipse IDE for Eclipse IDE for

ModusToolbox™ ModusToolbox™
« Start ~ Start

: New Application : New Application

[ Import Existing Application In-Place [ Import Existing Application In-Place

& Search Online for Code Examples & Search Online for Code Examples

& Search Online for Libraries and BSPs & Search Online for Libraries and BSPs

& Training Material & Training Material

&, Refresh Quick Panel @, Refresh Quick Panel
= Hello_Weorld (APP_CYSCKIT-062-WIFI-BT) = LE_Hello_Client (CYW920819EVB-02)
&, Build Application &, Build Application

& Clean Application f Clean Application
= Launches ~ Launches

{s Hello_Waorld Debug (ILink) 4§ LE_Hello_Client Attach_JLink

%& Hello_Werld Debug (KitProg2_MiniProg4) i? LE_Hello_Client Attach_KitPreg3_MiniProgd
© Hello_World Pragram (ILink] @, LE_Hello_Client Program

0 Hello_Werld Pregram (KitProg3_MiniProg4) Q Generate Launches for LE_Hello_Client
‘% Generate Launches for Hello_Weorld + Tools

= Tools [y Library Manager 2.0

i) 8P Assistant 1.0 ~ BSP Configurators (CYW920819EVE-02)

[ Device Firmware Update Host Tool 1.60

& Device Configurator 4.0
[ Library Manager 2.0

« LE_Hello_Client Library Configurators
= BSP Configurators (APP_CY8CKIT-062-WIFI-BT)

g Bluetooth® Cenfigurator 2.60 (new configurator)
E CAPSENSE™ Cenfigurater 5.0

g CAPSENSE™ Tuner 5.0

& Device Configurater 4.0

[ OSPI Configurator 4.0

[ Segment LCD Cenfigurator 1.50 (new configurator)

[ Smart 10 Configurator 4.0

+ LE_Hello_Client APl Documentation

[5] AIROC™ Bluetooth® SDK Documentation

~ Hello_ World Library Configurators
[ Bluetooth® Configurator 2.60 (new configurator)
&5 LIN Configurator 1.2
& ML Configurator

0 (new configurater)

{new configurator)

: USE Configurater 2.50 (new configurater)

= Hello_ World APl Documentation

< >

The Quick Panel contains links to various commands and documentation, organized as follows:

e Start - This contains the New Application link to create new applications, and links to find Code Examples,
Libraries, BSPs, and training material.

¢ Selected <app-name> project - This contains different project-related links based on the project that is
selected in the Project Explorer, as well as the type of application. Links here include: Build and Clean the
application.

e Launches - This contains various Launch Configurations, based on the selected application project and
device, which can be used to program the device and launch the debugger. This area is only populated if
you have the top project in your application selected (<app-name>). For more information, see Launch
configurations.

e Tools - This contains links to the various tools available for the selected project. For more information, see
Use configurators and Use tools.

e Documentation - This may contain several documents in HTML format, which are included as part of the
chosen BSP.
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3 Configure applications

This chapter covers how to make various changes to your application. It includes:

¢ Modify code

e Use configurators

e Usetools
e Useintegrated terminal
e Refresh Quick Panel

e Rename single-core application

e Restore shared directory

3.1 Modify code

Most code examples work as they are, and there is no need to add or modify code in order to build or program
them. However, if you want to update and change an application to do something else, or if you are developing
your own application, open the appropriate file in the code editor.

e PSoC™ MCU: In the Project Explorer, double-click the main.c file.

©Pro. # #De.. HiRe. %Peri. ~ © HREADMEmd [ mainc -
B% Y § * including Cypress's product in a High Risk Product, the manufacturer ~
« & Hello_World * of such system or application assumes all risk of such use and in doing
) Includes * so agrees to indemnify Cypress against all liability.
b ld *******************************************************************************/
& bui
& deps 7 #include "cy pdl.h"
= images 2 #include "cyhal.h"
& libs #include "cybsp.h"
2 #include "cy_retarget_io.h"
= LICENSE
_OMakeﬁle 7/*******************************************************************************
= makefile.init * Macros
READMEmd *******************************************************************************/
Note: The "includes" in this example show "unresolved inclusions" because the files are located in the

mtb_shared folder. This and other issues with IntelliSense are resolved after a build.

o AIROC™ Bluetooth®: In the Project Explorer, expand the <app-name> project folder and double-click the
application <app-name>.cfile.

[f5 Proj.. 32 g Deb.. ilfRegi. T Peri. = B  [g hello_sensorc i3 = O
BS Y 3 "
VT_.'_—'E' LE_Hello_Sensor ~ } hello_senser_state_t;
B oo -
3, Binaries #pragma pack(1)
[ Includes /* Host information saved in  NVRAM */
(= build = typedef PACKED struct
= COMPONENT_CYW920721B2EVK-03_design_m
d BD_ADDR  bdaddr; /* BD address of
=4 _EPS uintle_t characteristic_client_ceonfiguration; /* Current value
(= libs uint8_t  number_of blinks; /* Sensor config
E hello_sensar.c } hest_info_t;
\A[ hello_sensar. #pragma pack()
Efwiced_bt_cfg.c tvpedef struct
2] LICENSE.txt {ype £ struc
Lg makefile uintlé_t handle;
|=| makefile.init uintlé_t attr_len;
[w] README.md w void *p_attr;
< > } attribute_t;
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As you type into the file, an asterisk (*) will appear in the file’s tab to indicate changes were made. The
Save/Save As commands will also become available to select.

3.2 Use configurators

ModusToolbox™ software provides graphical applications called configurators that make it easier to configure
a hardware block. However, before you make changes to settings in configurators, you should first copy the
configuration information to the application and override the BSP configuration or create a custom BSP. If you
make changes to a standard BSP library, it will cause the repo to become dirty. Additionally, if the BSP is in the
shared asset repository, changes will impact all applications that use the shared BSP. For more information,
refer to the ModusToolbox™ tools package user guide.

Each configurator provides a separate guide, available from the configurator's Help menu.

3.2.1 Launching configurators from the IDE

To launch a configurator from the Eclipse IDE, right-click on the <app-name> project in the Project Explorer,
select ModusToolbox™, and then select the appropriate configurator.

NEW
& Project Explore .
1= Hello_Worlc Open in New Window
& mtb_shared Show In Alt+Shift+W >
= ModusToolbox™ > BSP Assistant 1.0
Show in Local Terminal ? CAPSENSE™ Configurator 5.0
[E Copy Ctrl+C CAPSENSE™ Tuner 5.0
Paste Ctrl+V Device Configurator 4.0
% Delete Delete Device Firmware Update Host Tool 1.60
Source ’ Library Manager 2.0
Move.. Project Creator 2.0
Rename... 2 QSPI Configurator 4.0
&1 Import... Smart I/O Configurator 4.0
i Export... Segment LCD Configurator 1.50 (new configurator)
Build Project Bluetooth® Configurator 2.60 (new configurator)
& Quick Panel ¢ Clean Project USB Configurator 2.50 (new configurator)
Note: You can also launch available configurators from links in the Quick Panel.

Depending on the enabled resources in your application, there may be several configurators available to
launch.

¢ Ifyou launch the Device Configurator from the IDE, you are opening the project’s design.modus file, which is
responsible for holding all of the BSP configuration information. It contains the following:
e Selected device
e Resource parameters
e Constraints

e Ifyou launch any of the other configurators from the IDE, they will open using that configurator’s
configuration file (design.cycapsense, design.cyseglcd, etc.). These files are specific to the given resource,
and they may rely on configuration data from the design.modus file.

3.2.2 Launching configurators without the IDE

To launch any Configurator without using the IDE, refer to the applicable configurator guide for details about
configuration information. You may need to open a configuration file or create a new one.
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3.3 Use tools

In addition to the configurators, there are several tools, including Library Manager, BTSpy, ClientControl, and
Device Firmware Update (DFU) Host Tool. Many tools do not apply to all types of projects. So, the available
tools depend on the project/application you have selected in the Project Explorer.

3.3.1 Launching tools from the IDE

To launch a tool from the Eclipse IDE, right-click on the <app-name=> project in the Project Explorer, select
ModusToolbox™, and then select the appropriate tool.

Byp 32 4D WER ZP = O

2

w =% Empty_BTSDV Aem =

[l Includes New ?
= build Go Into
~ d
F? |-Ep5 Open in New Window
= libs
[€ app_bt_c Show In Alt+Shift+W >
app_bt_c E ModusToolbox™ ¥ Library Manager 1.40 Ctrl+8
% empty_w Show in Local Terminal > BTSpy
cycfg_bt. ;
= LICENSE: [2 Copy Ctrl+C Blluetooth Configurator 2,50
makefile Paste CtrlsV ClientControl
= makefile, 3¢ Delete Delete Device Configurator 3.10
Note: You can also launch available tools from links in the Quick Panel.
3.3.2 Library Manager

The Library Manager allows you to select which Board Support Package (BSP) and version should be used by
default when building a ModusToolbox™ application. It also allows you to add and remove libraries, as well as
change their versions.

For more information about how to use this tool, refer to the Library Manager user guide.

3.3.3 BTSpy and ClientControl

BTSpy is a trace utility that can be used in the AIROC™ Bluetooth® applications to view protocol and generic
trace messages from the embedded device. The tool listens on the UDP port 9876 and can receive specially
formatted message from another application on the same or different system.

BTSpy can be used in conjunction with ClientControl to receive, decode and display protocol application and
stack trace messages. ClientControl communicates with the embedded app to perform various functionalities,
tests, exercising features, etc.

3.3.4 DFU Host tool

The Device Firmware Update (DFU) Host tool is a stand-alone program used to communicate with a PSoC™
MCU that has already been programmed with an application that includes device firmware update capability.
For more information, refer to the Device Firmware Update Host tool user guide.
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3.4 Use integrated terminal

The Eclipse IDE for ModusToolbox™ software includes an integrated terminal where you can enter various
commands for the selected project. To view the terminal, click the Terminal tab in the bottom pane. Then,
select a project in the Project Explorer to open a shell in the project directory.

[ mtw3.0 - Hello_World/README.md - Eclipse IDE for ModusToolbox™ - O «

File Edit Navigate Search Project Run Window Help

Nv - v a8 > HEvOvYR_R Y™ v v - Sv o ov | Q x|&

GPro... © #De.. “Re.. %Per. ~ © [EREADMEmd I & Outline

PSoC™ 6 MCU: Hello world ™ v b oCaade s MC
&> mtb_shared h2. Requirements
h2. Supported toolq
This code example demonstrates simple UART communication by printing h2. Supported kits
the "Hello world" message on a terminal and blinks an LED using a timer h2. Hardware setup
resource in PSoC™ 6 MCU. h2. Software setup
h2. Using the code ¢
View this README on GitHub. h2. Operation

h2. Debugging

Provide feedback on this code example. « h2. Design and impl

h3. Resources an

Req u i re m e nts h2. Related resource)

h2. Other resources
= Qui.. “Vari.. % Exp.. ®eBre.. 2 h2. Document histol

* ModusToolbox&trade; software v2.2 or later (tested with v2.3)

Eclipse IDE for A S ; :
P - « Board support package (BSP) minimum required version: 2.0.0 o
ModusToolbox
< >
» Start Markdown Source Preview < >
» Hello_World Q Console #: Problems 0 Memon/ e =8 &
» Launches B2 Hello_World ModusShell ¢

» Tools

~/mtw3.0/Hello_World

» BSP Configurators (<bsp-name>)

~ Hello_ World Library Configurators
& Bluetooth® Configurator 2.60 (new ¢ ,
< >
Connected - Encoding: Default (ISO-8859-1)

Note: You can configure the terminal colors for the Workspace under Window > Preferences >Terminal.

3.4.1 Switch projects

When you switch projects, the Eclipse IDE creates additional tabs and automatically switches between them, so
that a shellin the current project directory is always in focus. To disable this automatic switching, deselect the
Track Current Project button in the terminal toolbar.

B Console [#] Problems [ Memory 8 Terminal 32 2 .;:f| i ® of .;\,,ﬁ = 8
& Helle_Werld ModusShell 2 AnyCloud_BLE_CapSense_Buttons_and_Slider ModusShell &2

ns_and_Slider
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3.4.2 Specify alternate shell

By default, the terminal uses your login shell on Linux and macOS, or the "modus-shell" Cygwin bash shell
provided with your ModusToolbox™ tools installation on Windows. You can specify a different shell from

Window > Preferences > ModusToolbox™ Tools.

E Preferences

| type filter text | MeodusToolbox™ Tools

General

oo

*

2
- &
=S

C/C++

| Shell for terminal view | |

Browse... |

Context

Help Argurnents to shell | --login -i

Install/Update

MCU

MeodusToolbox™ Tools
Remote Development
Run/Debug

Team

Terminal

Restore Defaults

Apply

Apply and Close

Cancel

3.4.3

Update local terminal settings

By default, the local terminal uses your User home directory as the Initial Working Directory. You can specify
different options from Window > Preferences > Local Terminal.

| Preferences [m] x
Local Terminal G-
General | » General
CiCes Local Terminal Settings: » Clce+
Context Initial Warking Directary | Conemt
Hel,
Help ‘ User home ~| | Browse. Variables.. : |netpll Updat
Install/Update — — . wtall/pdate
MCU Note: The chosen initial working directory might be overwritten by the current » Mcu
selection of the active view. | ™
ModusToolbox™ Tools | 'R""d“:"’m‘f""’l" “"“‘
N
Remote Development "Show I ..." Custom Entries . ;“}‘[’) “b 9" oprmen
" un/Debu
Run/Debug Narme Path Add.. > Team
Jeam Git Bash C:\Users\follettcjiAppDatalLocal\P | > Terminal
v Termingl ' VPP Edit... Local Terminal
Local Terminal |
Remove
Restore Defaults Apply |
@ pa b Apply and Close Cancel
?

Note:

User Guide

Local Terminal

Local Terminal Settings:
Shell Command

Browse.
Arguments:

Note: Leave the shell command empty to fallback to the SHELL environment variable or if
not set, to /bin/sh.

Initial Working Directory

User home - Browse. Variables.
Note: The chosen initial working directory might be overwritten by the current selection of

the active view.

Show In ..." Custom Entries

Restore Defaults Apply

Apply and Close

Cancel

Linux and macOS include additional settings for Shell Command and Arguments.
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3.44 Connect to remote machine/board

You can also connect to a remote machine or board via serial, telnet, or SSH by clicking the Open a Terminal
button in the terminal toolbar.

B Console [Z Problems [J Memory @ Terminal i3 S, |$‘~f | i ® of & =8
& Hello_World ModusShell 2 AnyCloud_BLE_CapSense_Buttons_and_Slider ModusShell 23

oud_BLE_CapSense_Buttons_and_Slider

Q Launch Terminal

Choose terminal: | (Git Bash

Settings
Encoding: | UTF-8 ~
@

Use the Choose terminal pull-down menu to select the appropriate terminal.

3.5 Refresh Quick Panel

When you use tools external to the Eclipse IDE, such as the Library Manager or Device Configurator, it is likely
that the Eclipse IDE will not refresh to detect changes made in those other tools. Use this link to refresh the
Eclipse IDE. You may notice new documentation links or a new Active BSP in the Quick Panel as an indication
that your application has new libraries and/or components.

=Quic. -Vari. * Expr. %Brea. = U

Eclipse IDE for ~
ModusToolbox™

~ Start

= New Application

= Import Existing Application In-Place

@ Search Online for Code Examples

@ Search Online for Libraries and BSPs

& Training Material

A Refresh Quick Panel
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3.6 Rename application

3.6.1 Single-core application

The Eclipse IDE for ModusToolbox™ software uses the standard Eclipse rename functionality. That is, right-click
on the application and select Rename. If you use the rename feature, you will need to update your
application’s launch configurations. The easiest way to do this is to use the "Generate Launches..." link in the
Quick Panel.

After renaming the application, select it in the Project Explorer and notice that there is only one item under
Launches. Click on the Generate Launches for... link. After a few moments, the generate process completes.
Click on the application again in the Project Explorer and notice that all the items are shown under Launches in
the Quick Panel.

» Start » Start

» Rename_Application * Rename_Application

~ Launches

~ Launches
% Generate Launches for Rename_Application ¥ Rename_Application Debug (JLink)
» Tools ki Rename_Application Debug (KitProg3_MiniProg4)
» BSP Configurators (<bsp-name=>) © Rename Application Program (JLink)
» Hello World Library Configurators o Rename_Application Program (KitProg3_MiniProg4)
Y Hallo Wotld APl Docimantatas & Generate Launches for Rename_Application
+ Tools

» BSP Configurators (<bsp-name>)

* Hello_ World Library Configurators

» Hello World APl Documentation

3.6.2 Multi-core application

For a multi-core application, you also use the standard Eclipse rename functionality; however, there are a few
additional steps required. After renaming the main application project, you'll notice that the core subprojects
become regular folders.

[ Project Explorer % 5% Y 3 =8

125 mtb_shared
v R
= bsps
= proj_cmip
= proj_cm7_0
= proj_cm7_1
@ common_app.mk
& common.mk
|Z LICENSE
& Makefile
README.md

Select each folder, right-click, and select Import as Project.

[ Project Explore Go Into
- Zz ;‘:;:‘:;Ed Open in New Window
= bsps Show In AltsShift=W >
= proj_cmi Show in Local Terminal ¥
B B oy Culec
& commor Paste Ctrl+V
@ commor 3§ Delete Delete
B LICENSE  grce »
@ Makefile Move..
[¥ README
Rename... F2
1= Import as Project h
Note: During the rename process, you may see index errors. These usually go away when the rename
process is complete.
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After making each folder a subproject, notice that each retains the prefix of the original application name.

[¥5 Project Explorer 53 S Y 8 = 0O
=5 mtb_shared
v =5 Renamed
(= bsps
{25 HMC-7000-Wiult, proj. cmip [
L ’Me-7000-Multhproj_em? |
125 ¥MC-7000-Multi.proj_em7_1 (in

@ common_app.mk
& common.mk

=| LICENSE

& Makefile

[#) README.md

You can rename each subproject individually, but ensure they each have a unique name. You can do so by
keeping the suffix.

| Rename Resource m] ®

New name: | (TSRS proj_cm0p
nces

When complete with the rename process, you may have to build the application or click the Generate
Launches for ... link as described under Single-core application.

3.7 Restore shared directory

Beginning with the ModusToolbox™ 2.2 release, shared BSPs, libraries, and versions are located in a shared
directory (named mtb_shared, by default) adjacent to your application directories. You can delete the
mtb_shared directory at any time because it can be recreated. You might do this when sharing the application,
for example. The shared directory only contains files that are already controlled and versioned, so you should
NOT check it into a revision control system.

When using the Eclipse IDE, if you delete the shared library directory from disk and then regenerate it, the
directory will not be restored properly. This is because several files required by the Eclipse IDE are not restored
as they were when the application was created. To resolve this:

1. Regenerate the mtb_shared directory and assorted libraries on disk using make getlibs orthe Library
Manager.

2. Inthe Eclipse IDE, delete the "mtb_shared" folder shown in the Project Explorer.

Note: Do NOT select the check box "Delete project contents on disk" (if you do, you will have to
regenerate it again).
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3. Then, select File > Import > C/C++ > Existing Code as Makefile Project and click Next >

4,

Select

Select an import wizard:

type filter text

Creates a new Makefile project in a directory containing existing code

243

(= General
v (= C/C++
[E] C/C++ Executable
ﬁ.ﬁj C/C++ Project Settings
Existing Code as Makefile Project
= Git
= Install

Cancel

On the Import Existing Code page:

Import Existing Code

Create a new Makefile project from existing code in that same directory

Project Name
mtb_shared

Existing Code Location

C:\Users\SirrineCaith\mtw3.0\mtb_shared

| Browse... |

Languages

M e+

Toolchain for Indexer Settings

Cross GCC

Show only available toolchains that support this platform

<pnone>
ARM Cross GCC |

Cancel

a. Under Existing Code Location, click Browse..., navigate to the application's root directory, select
the "mtb_shared" folder, and click Select Folder.

b. Under Toolchain for Indexer Settings, select ARM Cross GCC.

c. Click Finish.

5. After the import completes, build the application.
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4 Build applications

This chapter covers various aspects of building applications. Building applications is not specifically required,
because building is performed as part of the programming and debugging process. However, if you are running
the Eclipse IDE without any hardware attached, you may wish to build your application to ensure all the code is
correct. If you changed code in one of your projects, you may wish to build just that project.

e Build with Make
e Build with IDE

e GCCversion

4.1 Build with Make

You can build applications from the command line using Make. Refer to the ModusToolbox™ tools package user
guide (also located in the <install>/ide_<version>/docs directory) for more information. The document is also
available from the IDE's Help menu.

4,2 Build with IDE

After loading an application, it is best to first build everything to generate the necessary files. Click on a project
in the Project Explorer. Then in the Quick Panel, click the "Build <app-name> Application" link.

~ Hello World

A Build Application

¥ Clean Application

~ Launches

* Hello_World Debug (JLink)

* Hello_World Debug (KitProg3_MiniProg4)
] Hello_World Program (JLink)

0o Hello_World Program (KitProg3_MiniProg4)
A Generate Launches for Hello_World

» Tools v
< >

Building an application will typically allow IntelliSense to work better. It may also be useful to right-click on a
project and select Index > Rebuild to allow IntelliSense to find references.

Messages display in the Console, indicating whether the build was successful or not.

& Console &3 @ﬁﬁﬂ B =i iEal“"E'::?':'E'
CDT Build Consecle [HelloWorld]

[ .data | ©x@gewlisc | 194 I -

| .cy_sharedmem | exesee2azg | 12 |

| .moinit | exeses2a3s | 148 |

| .bss | exese@lacc | 964 |

| .heap | exespe2e08 | 276848 |

| .cy_sflash_user_d | exleeeeses | 8 |

| .ey toc_part2 | exlsea7ced | 512 |

Total Internal Flash (Available) 1848576

Total Internal Flash (Utilized) 44772

Total Internal SRAM (Available) 292864

Total Internal SRAM (Utilized) 279928

B7:27:22 Build Finished. @ errors, @ warnings. (took 43s.348ms)

< >
Note: Be aware that there are several Console views available.
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You can access the different views using the Display Selected Console Q- button (or the pull-down arrow).
The Global Build Console is the only way to see all of the results in one place. If you just have the standard
Console open, it resets every time a new project in the application starts building. You won’t see any errors if
they are not on the final project that gets built.

For subsequent updates, you can build one or more projects using the right-click menu options. Any projects
that are dependent on the project being built will also be built. The Eclipse IDE supports all the usual
application and build options available for the native Eclipse IDE.

Note: When the active build configuration is changed it affects only the selected project. The active build
configuration for any dependent projects is specified separately for each project. Therefore, if you
want to use the same configuration for all projects (for example, Debug or Release), it must be set
for each project. It is possible to select multiple projects at once from the Project Explorer and then
select the active configuration.

4.3 GCC version

ModusToolbox™ software includes GCC version 10.2 as the preferred toolchain to use with the Eclipse IDE. If
you have a different version of GCC you prefer, update the project properties to point to the appropriate
toolchain folder. Open the project Properties dialog, and click the Toolchains tab, and then click the
appropriate link to update global or workspace preferences, or project properties.

type filter text Settings Cw v B
Resource ~
ARM Toolchains Paths seration: |PEETA Po—

- ~
Builders Configuration: Debug [ Active ] Manage Configurations...
¥ C/C++ Build
Build Variables ® Toolchains |B Devices @ Binary Parsers @ Error Parsers
Environment
Logging Name: \ GNU MCU Eclipse ARM Embedded GCC (arm-none-eabi-gcc) -
Saiiligs Architecture: ARM (AArch32)
Tool Chain Editor Prefi
C/Cr+ General refix: arm-none-eabi-
Project Natures Suffix [ ]
Project References C compiler:
Run/Debug Settings C++ compiler:
WikiText
Archiver: ar
Hex/Bin converter: | objcopy
Listing generator: | objdump
Size command
Build command:
Remove command:
Toolchain path: ‘ ${cy_tools_path:CY_TOOL_gcc BASE}/ bin ‘
(to change it use the global or workspace preferences pages or the project properties page)
Build tools path: ‘ ${cy_tools_path:CY_TOOL modus-shell BASE}/bin ‘
(to change it use the global or workspace preferences pages or the project properties page)
Create flash image
[[] Create extended listing
Print size .
®@ Apply and Close Cancel
H *
User Guide 250f 35 002-24375 Rev. *J

2022-09-27



o~ _.
Eclipse IDE for ModusToolbox™ user guide < In f| neon

Program and debug

5 Program and debug

Programming and debugging is native to your chosen development environment. Cypress devices are
supported in the major program and development solutions. Primarily, this means J-Link and OpenOCD. These
solutions provide for programming flash within a device and provide a GDB server for debugging.

This chapter covers various topics related to building and debugging, including:

e PSoC™MCU programming/debugging

e Launch configurations

e Using JTAG interface in MiniProg4

e Erasing external memory

e Programming eFuse

e Debug connection options
e Select specific CMSIS-DAP device

e Select specific J-Link device

e KitProg Firmware Loader

e PSoC™4 flash security programming

e AIROC™ Bluetooth® programming/debugging

e Program configuration

e Attach configurations

e Debug settings

5.1 PSoC™ MCU programming/debugging

5.1.1 Launch configurations

The flow for programming and debugging is similar for all devices. The Eclipse IDE contains several Launch
Configurations that control various settings for programming the devices and launching the debugger.
Depending on the kit and type of applications you are using, there are various Launch Configurations available.

There are two sets of configurations: one for KitProg3_MiniProg4 (included on-board on most Cypress PSoC™ 6
and PSoC™ 4 based kits) and another for SEGGER J-Link.

Note: The KitProg3_MiniProg4 launch configuration also supports the MiniProg4, which you attach to
the kit via a 10-pin debug connection. See the MiniProg4 product page for details. The MiniProg3 is
not supported.
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The Launch Configurations are shown in the Run/Debug Configurations dialog, similar to the following.

[ Debug Configurations O *

Create, manage, and run configurations

.ﬁ c =5 Yo Configure launch settings from this dialeg:
| type filter text - Press the 'Mew Configuration’ button to...ate a configuration of the selected type.
[£] GDB Hardware Debugging - Press the 'New Prototype’ button to cre..iguration prototype of the selected type.

~ [ ] GDB OpenOCD Debugging
E Helle_World Attach (KitProg3_MiniProgd)
[£] Hello_World Debug (KitProg3_MiniProg4) =| - Press the 'Duplicate’ button to copy the selected configuration.
E Hello_World Erase (KitProg3_MiniProgd)
[£] Hello_World Program (KitProg3_MiniProg4)
[£] GDB PyOCD Debugging
~ [C] GDB SEGGER J-Link Debugging
E Hello_World Attach (JLink)
[£] Hello_World Debug {JLink) - Select launch configuration(s) and the...rototype’ menu item to link a prototype.
E Hello_World Erase (JLink)
E Hello_World Program (JLink)
R Launch Group - Select launch configuration(s) and the...enu item to reset with prototype values.

- Press the 'Export’ button to export the selected configurations.

3 - Press the 'Delete’ button to remove the selected configuration.

=

- Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

- Select launch configuration(s) and the...totype’ menu item to unlink a prototype.

Configure launch perspective settings from the 'Perspectives’ preference page.

Filter matched 13 of 17 items

@

Debug Close

You can open these dialogs from the Run menu or by selecting the down arrow ~ next to the Run and Debug
commands.

These configurations include the application name and protocol, for example:
Hello_World Program (KitProg3_MiniProg4)
Hello_World Debug (JLink)

Note: KitProg3_MiniProg4 configurations may not work if a J-Link probe is attached to the kit.

When an application is created, the tool generates the following launch configurations for both
KitProg3_MiniProg4 and J-Link. Some items display in the Quick Panel, and some are in the Run/Debug
Configurations dialog only.

e Attach: This launch configuration starts a Cortex-M4 debugging session attaching to a running PSoC™ 6
target without programming or reset.

e Debug: This launch configuration builds the entire application on both cores, programs all the device's
memories, and then starts a Cortex-M4 debugging session.

e Erase: This launch configuration erases all internal memories.

e Program: This launch configuration builds the entire application on both cores, programs all the device's
memories, and then runs the program.
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5.1.2 Using JTAG interface in MiniProg4

The MiniProg4 can interact with the target via the SWD or JTAG protocol. By default, the SWD protocol will be
used.

In order to use JTAG, you need to add specific commands for the appropriate Debug Configuration. Under the
Debugger tab in the Config options field (after -c "source [find interface/kitprog3.cfg]"), insert the following
lines:

Mame: | Hello_World Debug (KitProg3) |

[E Main | %% Debugger| = Startup % Source| [[] Common| &, SVD Path

O T e

Config options: -5 "/libs/TARGET_CYBCKIT-062-WIFI-BT/COMPOMNENT_BSP_DESIGM_MODUS/GeneratedSource” ~

5

-¢ "source [find interfacea'kitproqlch]"|
c
c

-c "puts stderr {Started by GNU MCU Eclipse}”
-¢ "source [find target/psoch.cfg]” W

Allocate console for OpenOCD Allocate console for the telnet connection

e -c "cmsis dap vid pid 0x04B4 O0xF151 0x04B4 OxF152"

e -c "transport select jtag"

5.1.3 Erasing external memory

By default, erasing of external memory is turned off. To erase it, you must modify the "Erase" launch
configuration options on the Debugger tab as follows:

For PSoC™ 64 Secure Boot kits, such as CYS8CKIT-0645052-4343W and CYSCPROTO0-064S1-SB, remove the
following to enable external memory erasing via SMIF:

-c "set DISABLE SMIF 1"

Name: | Hello_World Erase (KitProg3)

[ Main | %% Debugger| B+ Startup ¥ Source|[C] Common 7, SVD Path

Config options: -5 "${openacd_path}/../scripts"
-¢ "source [find interface/kitprog3.cfg]”
-c "set TARGET_AP cmd_ap"

|-c "set DISABLE SMIF 1"]

Allocate console for OpenQOCD Allocate console for the telnet connection

For all other kits, add the path to the GeneratedSource folder (after -s
"${openocd_path}/../scripts")

-s "./bsps/<TARGET NAME>/config/GeneratedSource"

Mame: | Hello_World Erase (KitProg3)

[E] Main | % Debugger| = Startup| % Source [C] Common | 2, SVD Path

Config options: -5 "S{openocd_path}/../scripts”

-5 "./libs/TARGET_CVSCKIT-062-WIFI-BT/COMPONENT_BSP_DESIGN_MODUS/GeneratedSource']

-c "source [find interface/kitprog3.cfg]”
-¢ "source [find target/psoch.cfg]”

Allocate console for OpenQCD Allocate console for the telnet connection
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5.1.4 Programming eFuse

PSoC™ 6 MCUs contain electronic fuses (eFuses), which are one-time programmable. They store device specific
information, protection settings and customer data.

By default, eFuses are not programmed even if they are present in the programming file. To enable eFuse
programming, add the following command for the appropriate Debug Configuration, under the Debugger tab
in the Config options field (after -c "source [find target/psoc6.cfgl™):

-c "psoc6 allow efuse program on"

Name: | HelloWorld Debug (KitProg3)

[2) Main | %5 Debugger | = Startup| 1 Source|[T] Common | &, SVD Path
rerpoTe. wiraor =

Config options: | -¢ "source [find interface/kitprog3.cfg]” "
-c "source [find target/psoch.cfg]”

¢ "psoch allow_efuse_program on"
-c "puts stderr {Started by GNU MCU Eclipse}" v

Allocate console for OpenOCD Allocate console for the telnet connection

Attention: Because blowing an eFuse is an irreversible process, Cypress recommends programming only
in mass production programming under controlled factory conditions and not prototyping
stages. Programming fuses requires the associated I/0 supply to be at a specific level: the
device VDDIOO (or VDDIO if only one VDDIO is present in the package) supply should be set to
2.5V (£5%).

5.1.5 Debug connection options

By default, a typical PSoC™ 6 application created in the Eclipse IDE includes launch configurations set up for
two probes: Cypress KitProg3 (built into Cypress kits) and Segger J-Link.

Communication Firmware Debug Connection More Information

Cypress-provided KitProg3 OpenOCD via CMSIS-DAP | https://www.cypress.com/products/psoc-programming-
solutions

SEGGER-provided J-Link DLL SEGGER J-Link SEGGER J-Link

5.1.6 Select specific CMSIS-DAP device

If there are two or more CMSIS-DAP devices connected to your computer, the first detected device will be used
by default. KitProg3 supports both CMSIS-DAP modes - HID and BULK. BULK devices are selected first, then HID
devices. You can specify a CMSIS-DAP device by:

e VID and PID of the USB device

o Serial Number of the USB device

e VID, PID, and Serial Number of the USB device

To do this, you must add a specific command for the appropriate Debug Configuration, under the Debugger
tab in the Config options field (after -c "source [find interface/kitprog3.cfg]")

Name: | BlinkyLED Debug (KitProg3) |

[Z] Main | %5 Debugger| = Startup 5 Source| [C] Common | 2, SVD Path
rerpETh b

Config options: -5 "$workspace_locl/BlinkyLED_config/GeneratedSource” ”~
-c "source [find interface/kitprog3.cfg]”
-¢ "source [find target/psoch.cfg)"|
-c "gdb_port 3332" v
Allocate console for OpenQCD Allocate console for the telnet connection
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5.1.6.1 Selecting by VID and PID

Use OS-specific tools to determine the VID and PID of connected devices. For example, on Windows, use the
Device Manager. Use the "cmsis_dap_vid_pid" command to select a CMSIS-DAP device with a specific VID and
PID. If there are two or more devices with the same specified VID/PID pair, OpenOCD uses the first detected
device from the passed list.

e To specify KitProg3 in CMSIS-DAP BULK mode with VID = 0x04B4 and PID = 0xF155:
cmsis dap vid pid 0x04B4 O0xF155

e To specify KitProg3 in CMSIS-DAP HID mode with VID = 0x04B4 and PID = 0xF154:
cmsis _dap vid pid 0x04B4 O0xF154

e To specify any (HID or BULK) connected KitProg3 device:
cmsis dap vid pid 0x04B4 O0xF154 0x04B4 OxF155

5.1.6.2 Selecting by serial number

There should not be more than one device with the same serial number. Use this method if you want to use
only one specific device. Use OS-specific tools to determine the Serial Number of connected devices. You can
also use the fw-loader utility with --device-1ist option. See KitProg Firmware Loader.

Use the "cmsis_dap_serial" command to select a CMSIS-DAP device with a specific Serial Number.

e To specify a CMSIS-DAP device with Serial Number = 0BOBOF9701047400 the following command is used:
cmsis_dap serial O0BOBOF9701047400

5.1.6.3 Selecting by both VID/PID and serial number

You can use both commands together in any order. For example:

cmsis dap vid pid 04B4 F155 cmsis dap serial OBOBOF9701047400

5.1.7 Select Specific J-Link Device

If there are two or more J-Link devices connected to your computer, the first detected device is used by default.
You can select a specific J-link device by setting the serial number for the appropriate Debug Configuration,
under the Debugger tab:

Name: | BlinkyLED Debug (J-Link)
B Main (ESciangy  Satup| Bp Source| [ Comman| 3, SVDPath|

(to change it use the global or workspace preferences pages or the project properties page)
Devicename: | CYBCHaT_CM4 sect256KE |

Endianness: @Litle  OBig
Connec tion: @ use op I 504402250 (USB serial or IP name/address)
Interface: @ SWD O ITAG
Initial speed: @ Auto (O Adaptive () Fixed kHz
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5.1.8 KitProg Firmware Loader

The PSoC™ MCU kits include onboard programmer/debug firmware, called KitProg. The CYSCPROTO-062-
4343W kit has KitProg3 by default. However, the CY8CKIT-062-BLE and CY8CKIT-062-WIFI-BT kits come with
KitProg2 firmware installed, which does not work with the ModusToolbox™ software. You must update to
KitProg3. KitProg3 provides the CMSIS-DAP (Bulk) protocol by default, which is up to ~2.5 times faster than the
CMSIS-DAP (HID) protocol. Both modes can be used via OpenOCD.

ModusToolbox™ software includes a command-line tool "fw-loader" to update kits and switch the KitProg
firmware from KitProg2 to KitProg3, and back. The following is the default installation directory of the tool:

<install_path>\ModusToolbox\tools_<version>\fw-loader\bin\

Use the fw-loader tool to update the KitProg firmware as required for your needs. KitProg2 does not work with
the ModusToolbox™ software. Likewise, if you update to KitProg3, PSoC™ Creator won’t work with kits until you
restore KitProg2.

Note: On a Linux machine, you must run the udev_rules\install_rules.sh script before the first run of the
fw-loader.

For more details, refer to the KitProg3 user guide. The fw-loader tool also provides a readme text file in the fw-
loader installation directory.

5.1.9 Power cycle programming mode with KitProg3_MiniProg4

By default, Launch Configurations use Reset mode to program the device. However, Reset mode is not available
in all situations (for example, if the XRES pin is not available on the part's package). In these cases, Launch
Configurations use an alternative reset using software. However, using the software reset type is not sufficient
in some cases when access to the device's DAP is restricted (such as when set by security settings).

If there is no XRES pin available and DAP access is restricted, the only way to reset a part is to use Power Cycle
mode. Follow these instructions to add commands to the launch configuration and switch to Power Cycle
mode.

1. Open the Launch Configuration to modify.
2. Select the Debugger tab.

3. Inthe Config options field, insert the following lines
(after -c "source [find interface/kitprog3.cfg]"):

Mame: | Empty_PSoC4_App Debug (KitProg3_MiniProg4) |

[£ Main | %% Debugger = Startup | % Source| ] Common| &, SVD Path
Config optiens: L-c "source [find interface/kitprog3.cfg]”

- "puts stderr {Started by GNU MCU Eclipse}"
-c "source [find target/psocd.cfg]”
-¢ "psecd.cpu configure -rtos auto -rtos-wipe-on-reset-halt 1"

Lllorate conenle for Onen(TT LAllorate conenle for the telnet cone

For PSoC™ 6:

-c "set ENABLE POWER SUPPLY <mV>"
-c "set ENABLE ACQUIRE 2"

For PSoC™ 4:

-c "set ENABLE POWER SUPPLY <mV>"
-c "set PSOC4 USE ACQUIRE 2"
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Where, <mv> defines target voltage in millivolts, (for example, use -c "set ENABLE POWER SUPPLY
3300" for3.3V).

Note: Verify the voltage range supported by the target MCU, since it can be damaged by supplying
unsupported voltage. Make sure that your MCU is not powered externally before supplying power
via the KitProg3_MiniProg4.

5.1.10 PSoC™ 4 flash security programming

PSoC™ 4 devices include a flexible flash-protection system that controls access to flash memory. This feature
secures proprietary code, but it can also be used to protect against inadvertent writes to the bootloader
portion of flash. Refer to the device’s Architecture Technical Reference Manual for details.

Flash consists of rows (64/128/256 bytes, depending on the PSoC™ 4 device). Each row of flash can have its
protection level independently set. You can assign one of two protection levels to each row, as shown in the
following table:

Protection Setting Allowed Not Allowed
Unprotected External read and write, Internal read and write -
Full Protection External read, Internal read External write, Internal write

To apply flash security, include the appropriate data in the application by creating an array of num_rows /8
size, where num_rows is the actual number of flash rows on the device. Each byte of this array is responsible for
protection of 8 flash rows, and it sets one of two protection levels:

e 0-unprotected

o 1 -full protection

For example, to protect the first 25 rows and the last 5 out of 256 rows, include the following array in your
application:

CY_SECTION(".cyflashprotect") _ USED
static const unsigned char flash protect[0x20] =

{
OxFF, OxFF, OxFF, 0x01, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00

}i

To enable flash security, program the device with the updated code. If you wish to reprogram a protected
device, you must first erase it.
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5.2 AIROC™ Bluetooth® programming/debugging

AIROC™ Bluetooth® applications have different launch configurations than PSoC™ MCU applications.
Bluetooth® applications use External Tools configurations for programming the device, and Attach
configurations for attaching to the debugger. The Program launch configurations are available from the Quick
Panel when you select <app name> project. Each configuration is preceded by the application name.

- Audio_20819EVB02
A Build Application

¥ Clean Application

~ Launches

# Audio_20819EVB02 Attach JLink
# Audio_20819EVBO02 Attach_KitProg3_MiniProg4
% Audio_20819EVBO2 Program

& Generate Launches for Audio_20819EVB02

+ Tools

5.2.1 Program configuration

This launch configuration runs a script and programs the device's memories.

e <app-name> Program: Program is used to build and program embedded applications onto the target
device.

5.2.2 Attach configurations

The Attach configurations are used to attach to the debugger without first programming the device. They
include:

e <app-name> Attach_JLink

e <app-name> Attach_KitProg3_MiniProg4

5.2.3 Debug settings

AIROC™ Bluetooth® devices use the JTAG SWD interface on a kit for debug via OpenOCD or J-Link probe.
Typically, GPIOs need to be reprogrammed (via firmware) to enable SWD, so debug can't be performed directly
after a device reset. The debugger is usually attached to a running device and symbols only are loaded.

The CYW920819EVB-02 and CYBT-213043-MESH kits have additional requirements in order to launch the Eclipse
IDE debugger. In general, most debugging for these kits is done with logs and sniffers, since real time execution
is usually needed for the protocols to run properly.

Refer to the AIROC™ Hardware Debugging document for more details.
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https://infineon.github.io/btsdk-docs/BT-SDK/WICED-Hardware-Debugging.pdf
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IMPORTANT NOTICE

The information given in this document shall in no
event be regarded as a guarantee of conditions or
characteristics (“Beschaffenheitsgarantie”) .

With respect to any examples, hints or any typical
values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement of
intellectual property rights of any third party.

In addition, any information given in this document
is subject to customer’s compliance with its
obligations stated in this document and any
applicable legal requirements, norms and standards
concerning customer’s products and any use of the
product of Infineon Technologies in customer’s
applications.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

For further information on the product, technology.
delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon
Technologies, Infineon Technologies’ products may
not be used in any applications where a failure of the
product or any consequences of the use thereof can
reasonably be expected to result in personal injury.
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